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1. Introduction 

 

Inclusion in education is based on the idea of the social model of disability that it’s caused 

by barriers which are created when products and services, like learning in our case, are 

not designed to include people with different access needs so if those barriers are 

removed, then someone who has a disability can have equal experience to everyone 

else. Thus, Inclusive Distance Education is an essential component of contemporary 

learning, striving to provide equal opportunities for all students, regardless of their 

physical or cognitive abilities (Das, S., 2024). 

The primary objective of inclusion in education is to guarantee that every student has 

access to the necessary resources and support to succeed. Consequently, inclusion and 

equity should be the foundational principles guiding all educational policies, plans, and 

practices. This means that any educational approach, including distance education, must 

be designed to be accessible to all students, irrespective of their contexts and personal 

characteristics (UNESCO, 2017).  

UNESCO emphasizes the need to provide high-quality support to vulnerable students in 

distance education. This could include technical support, adaptations in educational 

materials, and personalized assistance for those who may have difficulties accessing or 

participating in online learning. 

One of the significant benefits of inclusive distance education is its accessibility. It allows 

students to learn from anywhere, providing flexibility that accommodates diverse learning 

needs. Additionally, it offers a variety of learning materials and personalized learning 

experiences, which can be tailored to individual preferences and requirements. 

However, inclusive distance education also faces several challenges. Technological 

barriers can prevent some students from accessing online resources. There is often a 

lack of training for educators on how to effectively support students with disabilities. 

Furthermore, limited access to resources and the potential for social isolation are also 

significant obstacles that need to be addressed when designing distance learning. 

 

To overcome these challenges, several strategies has been implemented: 

• The use of assistive technologies, such as screen readers and speech-to-text 

software, has greatly enhanced accessibility. 
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• Teacher training programs have been implemented to equip educators with the 

skills needed to support all students. 

• Inclusive curricula have been developed, and community and peer support are 

fostered to ensure that all students feel included and supported. 

Key technologies play a vital role in inclusive distance education. Tools such as screen 

readers, magnifiers, and interactive learning platforms can make a significant difference. 

Speech-to-text software and adaptive learning platforms also contribute to creating an 

inclusive learning environment. 

Looking ahead, the future of inclusive distance education is promising. Emerging trends 

and innovations in technology are likely to further enhance accessibility and inclusivity. 

The long-term impact of these advancements will be significant, potentially transforming 

the educational landscape. 

All these considerations reflect a commitment to diversity and social responsibility. By 

incorporating accessibility features such as screen readers, captions, and keyboard 

navigation, educators can enhance the learning experience for everyone, including those 

with temporary impairments or different learning preferences. Moreover, accessible 

courses can lead to higher student satisfaction and retention rates, as they 

accommodate a wider range of needs and learning styles. Ultimately, creating accessible 

digital courses is about providing equitable opportunities for all learners to achieve their 

academic goals and thrive in an increasingly digital world. 

 

1.1 Objective 

The objective of this guide is to provide educators with a starting point for creating 

accessible distance education courses. By reviewing various aspects, described in 

detail, educators will be able to develop online courses that are accessible to all students. 

Additionally, from a cognitive perspective, it is crucial to design courses that reduce 

cognitive load and enhance learning efficiency. This involves structuring information in 

manageable chunks, using clear and concise language, and incorporating visual aids to 

support textual information. By considering cognitive principles, educators can create a 

more effective and inclusive learning environment that caters to the diverse cognitive 

needs of all students. 

Moreover, through the next pages we will focus on three fundamental areas where 

concentrate our efforts to ensure accessibility in distance courses, like accessibility of 
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the educational platform, accessibility of content and compatibility with assistive 

technology. 

 

2. Legal framework and ethical considerations 

 

When we implement accessibility principles in our distance learning courses, persons 

with disabilities are more enabled to live independently and participate fully in all aspects 

of life (UN; 2006). 

A critical standard for ensuring the accessibility of digital products and services within 

the European Union is EN 301 549 and Directive (EU) 2016/2102, which ensures that 

websites and mobile applications of public sector bodies are accessible to all users, 

including those with disabilities. 

Particularly rule EN 301 549 is a key standard for ensuring the accessibility of digital 

products and services within the European Union (European Commission; 2021). This 

standard outline specific requirements that information and communication technology 

(ICT) products and services must meet to be accessible to people with disabilities. By 

adhering to EN 301 549, organizations can ensure that their digital content is 

perceivable, operable, understandable, and robust, aligning with the principles of the 

Web Content Accessibility Guidelines (WCAG). 

One of the primary reasons EN 301 549 is important is its role in legal compliance. The 

standard supports the European Directive 2016/2102 on the accessibility of websites 

and mobile applications of public sector bodies, commonly known as the Web 

Accessibility Directive. Compliance with EN 301 549 helps organizations avoid legal 

penalties and ensures they meet the mandatory accessibility requirements set by the 

directive. This is particularly crucial for public sector organizations and businesses 

operating in multiple European countries, as it provides a unified set of accessibility 

regulations. 

From a practical standpoint, EN 301 549 extends beyond web content to include a wide 

range of ICT products, such as software, hardware, and telecommunications equipment. 

This comprehensive approach ensures that all aspects of digital interaction are 

accessible, from websites and mobile apps to ATMs and ticketing machines. 

Moreover, EN 301 549 emphasizes the importance of designing digital content that is 

not only accessible but also user-friendly. This involves considering the cognitive load 
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on users and ensuring that information is presented in a clear and manageable way. By 

integrating cognitive design principles, such as breaking down complex information into 

smaller chunks and using visual aids, organizations can enhance the overall user 

experience and make their digital content more accessible to individuals with cognitive 

disabilities. 

On one hand, directive (EU) 2016/2102 focuses on ensuring that websites and mobile 

applications of public sector bodies are accessible to all users, including those with 

disabilities. For creating accessible distance learning courses, the directive emphasizes 

the need for content to be perceivable, operable, understandable, and robust. This 

means that all information and user interface components must be presented in ways 

that users can perceive, all functionalities must be operable by everyone, the information 

and operation of the user interface must be understandable, and the content must be 

robust enough to be interpreted reliably by a wide variety of user agents, including 

assistive technologies. 

Additionally, the directive mandates regular monitoring and reporting on accessibility 

compliance, ensuring that public sector bodies continuously improve their digital 

accessibility. This includes providing an accessibility statement on their websites and 

mobile applications, detailing the compliance status and offering a feedback mechanism 

for users to report accessibility issues. These measures aim to create an inclusive digital 

environment, making distance learning more accessible to all students. 

On the other hand, Web Content Accessibility Guidelines (WCAG) also play a crucial 

role in making digital courses accessible to everyone, including individuals with 

disabilities. By adhering to WCAG standards, course creators can ensure that their 

content is perceivable, operable, understandable, and robust. 

There are three levels of accessibility: A, AA and AAA. 

• Level A is the minimum standard, with 30 success criteria to meet 

• Level AA is the medium difficulty, adds 20 more criteria 

• Level AAA is the highest standard of accessibility, with an additional 28 success 

criteria 

This means providing clear and descriptive text, text alternatives for non-text content, 

ensuring that all functionality is available from a keyboard, making content easier to see 

and hear, optimizing color contrast and schemes, and providing captions and transcripts 

for multimedia. Also comprehends designing accessible interactions, ensuring 
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compatibility with assistive technologies, providing multiple ways to access content and 

implementing feedback mechanisms. 

It is also important that the Learning Management System (LMS) chosen, such as 

Moodle, complies with the Authoring Tool Accessibility Guidelines (ATAG). This allows 

instructors to create accessible content without advanced accessibility knowledge. 

Furthermore, conducting periodic audits with accessibility testing tools like WAVE, Axe, 

or Lighthouse can ensure that the platform meets established standards. Automated 

tools like these identify accessibility errors, facilitate human evaluation, and educate 

about web accessibility and should be used combined with manual testing to catch 

issues that automated tools might miss, such as the usability of interactive elements. 

Finally, test with real users. Involve people with disabilities in your testing process. Their 

feedback can provide insights that automated and manual testing might overlook. 

 

3. Universal design for learning 

 

UDL principles must be implemented to provide multiple means of representation, 

expression, and engagement. This approach ensures that content is accessible in 

various formats, catering to different learning styles and needs. 

Universal Design for Learning (UDL) offers diverse means of representation, expression, 

and engagement which can significantly enhance accessibility. This includes making 

content perceivable, operable, understandable and robust. 

When designing digital accessible courses, it is essential to consider several general 

accessibility principles to ensure that all students, regardless of their abilities, can 

effectively engage with the content. These principles are often encapsulated in the 

POUR framework: Perceivable, Operable, Understandable, and Robust (Pandey, 2021). 

 

Perceivable 

Perceivability ensures that all users can perceive the information being presented. This 

involves providing text alternatives for non-text content, such as images, videos, and 

audio files. For instance, images should have descriptive alt text, videos should include 

captions and transcripts, and audio content should be accompanied by text 

descriptions. Additionally, content should be presented in ways that can be perceived 
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by different senses, such as using high-contrast colors and readable fonts to aid those 

with visual impairments. 

 

Operable 

Operability means that all users should be able to navigate and interact with the course 

content. This includes ensuring that all functionalities are accessible via keyboard for 

users who cannot use a mouse. Interactive elements like forms, quizzes, and 

navigation menus should be designed to be keyboard-friendly. Moreover, providing 

sufficient time for users to read and use content, and avoiding content that can cause 

seizures, such as flashing lights, are crucial considerations. 

 

Understandable 

Understandability focuses on making the content clear and comprehensible. This 

involves using plain language, providing clear instructions, and ensuring that the course 

structure is logical and consistent. Content should appear and operate in predictable 

ways to avoid confusing users. Additionally, offering multiple ways to understand the 

content, such as through summaries, glossaries, and examples, can help cater to diverse 

learning needs. 

 

Robust 

Robustness ensures that content is compatible with a wide range of current and future 

user agents, including assistive technologies. This means using standard HTML and 

ARIA (Accessible Rich Internet Applications) landmarks to enhance compatibility with 

screen readers and other assistive devices. Regular testing with various technologies 

and updating content to comply with the latest accessibility standards are also important 

practices. 

 

4. Accessible platforms and videoconferencing tools 

 

It is essential that students can access the educational platform and use all its functions 

without barriers. If the platform has accessibility issues, the learning experience will be 
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severely affected. Assessing the accessibility of distance learning platforms helps 

educational institutions comply with legal requirements, such as the Americans with 

Disabilities Act (ADA) in the U.S., and avoid potential legal consequences. Accessible 

platforms enhance the overall learning experience by providing features like captions, alt 

text, and keyboard navigation, which benefit all students. Additionally, making courses 

accessible broadens the reach of educational institutions, allowing them to cater to a 

more diverse audience. Furthermore, accessible platforms can lead to higher 

engagement and retention rates, as students can interact with the content more 

effectively and comfortably. 

We must consider two fundamental aspects of the platforms: 

• Evaluation of LMS (Learning Management Systems) platforms for accessibility 

• Integration of tools, such as Immersive Reader, ZoomText, or NVDA 

 

Below we will take a look at some of the features of widely used distance learning 

platforms. 

 

1. Moodle 

Moodle is committed to ensuring accessibility for all users, regardless of their abilities. 

• Thus, the platform adheres to the Web Content Accessibility Guidelines (WCAG) 

2.1 Level AA, ensuring it meets global accessibility standards. 

• Moodle undergoes rigorous external audits by consultants to maintain 

compliance. 

• Key accessibility features include full keyboard navigation, screen reader 

compatibility, high-contrast themes, and an accessible media player. 

• Moodle's content creation tools are designed to be accessible, allowing 

educators to create content without advanced accessibility knowledge. 

• The platform continuously updates to enhance accessibility, incorporating 

feedback from users and experts. 

 

2. Canvas LMS 

Canvas LMS is designed with accessibility in mind, adhering to the Web Content 

Accessibility Guidelines (WCAG) 2.1 Level AA and Section 508 standards. 
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• The platform undergoes regular internal and third-party audits to ensure 

compliance and address any accessibility issues promptly. 

• Key features include compatibility with screen readers like JAWS, NVDA, and 

VoiceOver, as well as full keyboard navigation and the use of ARIA landmarks 

for better navigation. 

• Canvas also offers a built-in accessibility checker to help instructors create 

accessible content. 

• Additionally, the platform provides high-contrast themes and an accessible media 

player to support users with visual impairments. 

These efforts ensure that Canvas remains a robust and inclusive learning management 

system for all users. 

• Compatible with WCAG 2.1 AA and Section 508 (U.S.) 

• Clean and user-friendly interface with accessible navigation 

• Automatic generation of subtitles for videos 

• Access to tools like Immersive Reader for content customization 

 

3. Blackboard Learn 

Blackboard Learn is designed to be accessible and inclusive, adhering to the Web 

Content Accessibility Guidelines (WCAG) 2.1 and Section 508 standards. 

• The platform undergoes regular internal and third-party audits to ensure 

compliance and address any accessibility issues. 

• Key features include compatibility with screen readers like JAWS and VoiceOver, 

full keyboard navigation, and a consistent page structure to aid navigation. 

• Blackboard Learn also supports captions for all media types and provides tools 

for creating accessible content, such as an accessibility checker. 

These features ensure that Blackboard Learn remains a robust and inclusive learning 

management system for all users. 

• High accessibility standards, certified by organizations like the National 

Federation of the Blind (NFB) 

• Integration with screen readers and accessibility tools 

• Ability to create content in accessible formats 
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4. Brightspace (D2L) 

Brightspace (D2L) is designed to be highly accessible, adhering to the Web Content 

Accessibility Guidelines (WCAG) 2.1 Level AA and Section 508 standards. 

• The platform includes features to support users with disabilities, such as 

compatibility with screen readers, full keyboard navigation, and high contrast 

themes. 

• Brightspace also offers an accessibility checker to help instructors create 

accessible content and provides descriptive alternative text for images. 

• Additionally, the platform supports magnification and zoom functionality, and 

allows users to customize their account settings to better suit their needs. 

These features ensure that Brightspace remains an inclusive and user-friendly learning 

management system for all learners. 

• Complies with WCAG 2.1 AA and Section 508 

• Responsive and customizable design for users with visual or motor disabilities 

• Integrated accessibility tools, such as subtitle generation and accessible 

content editing 

 

5. Google Classroom 

Google Classroom is designed to be accessible and inclusive, supporting a variety of 

needs. 

• The platform adheres to the Web Content Accessibility Guidelines (WCAG) 2.1 

and includes features such as compatibility with screen readers, voice typing, 

and braille displays.  

• Google Classroom also supports full keyboard navigation and provides high-

contrast themes to assist users with visual impairments. 

Additionally, it offers tools like Select-to-Speak and ChromeVox for better content 

navigation. 

• Although not as robust as Moodle or Canvas, it has basic accessible 

functionalities 

• Compatible with screen readers 

• Keyboard navigation and support for subtitles in Google Meet 
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6. Edmodo 

Edmodo is designed to be user-friendly and accessible, supporting a variety of learning 

needs. 

• The platform offers a straightforward interface that simplifies navigation for both 

educators and students. 

• It is accessible via web and mobile devices, promoting continuous learning 

beyond traditional classrooms. 

• Edmodo enhances student engagement through interactive learning activities 

and real-time interaction, which supports diverse learning styles. 

Additionally, it provides tools for assignment tracking and progress monitoring, making it 

particularly useful for blended and remote learning environments. 

• Simple and accessible interface, but with some limitations depending on the type 

of content 

• Allows content customization and creation of inclusive materials, though it 

depends on the teacher to ensure accessibility 

 

7. Open edX 

Open edX is designed to be highly accessible, adhering to the Web Content Accessibility 

Guidelines (WCAG) 2.2 Level AA. 

• The platform includes features to support users with disabilities, such as 

compatibility with screen readers, full keyboard navigation, and high-contrast 

themes. 

• Open edX also provides an accessibility checker to help course creators ensure 

their content meets accessibility standards. 

• Additionally, the platform supports alternative text for images, semantic markup, 

and ARIA roles to enhance the accessibility of interactive elements. 

• Compatible with WCAG 2.2 

• A highly customizable platform that allows adding accessible tools 

• Accessible keyboard navigation and compatibility with screen readers 
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Discussion about platforms 

The overall accessibility of learning management systems (LMS) like Moodle, Canvas, 

Blackboard Learn, Brightspace (D2L), Google Classroom, Edmodo, and Open edX is 

generally robust, with each platform adhering to key accessibility standards such as the 

Web Content Accessibility Guidelines (WCAG) and Section 508. These platforms offer 

features like screen reader compatibility, full keyboard navigation, high contrast themes, 

and accessibility checkers to help ensure content is accessible to all users. They also 

support alternative text for images, semantic markup, and ARIA roles to enhance the 

accessibility of interactive elements. Regular audits and updates further ensure 

compliance and address any accessibility issues, making these LMSs inclusive and 

user-friendly for diverse learning needs. 

Although these platforms can be accessible by default, real accessibility will depend on 

the content uploaded by instructors and the specific configurations made. It is always 

recommended to: 

• Conduct accessibility audits on published courses 

• Train teachers in accessibility to maximize the platform’s potential. If you are 

considering a particular platform 

Among the most used platforms for videoconferencing, Zoom, Microsoft Teams, and 

Google Meet stand out for their efforts in accessibility, although each has strengths and 

areas for improvement. 

Here is a comparative analysis: 

1. Zoom Advantages 

• Compatible with screen readers (NVDA, JAWS, VoiceOver) 

• Accessible keyboard navigation 

• Real-time subtitles (manual or automatically generated) 

• Integration with sign language interpreters through customizable views 

• Contrast adjustments for text and backgrounds 

• Support for audio description in presentation 

Considerations: 

• Hosts need to enable automatic or manual subtitles 

• Some configurations can be complicated for less experienced users 
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2. Microsoft Teams Advantages 

• Real-time subtitles with multi-speaker recognition 

• Automatic transcriptions after the meeting 

• Full compatibility with screen readers and keyboard navigation 

• Support for interpreters with dual views in large meetings 

• Integration with Immersive Reader for transcriptions and messages 

• High contrast functionalities and clean design for users with visual disabilities 

Considerations: 

• It can consume more system resources, making it difficult to use on less powerful 

devices 

 

3. Google Meet Advantages 

• Real-time automatic subtitles, available in several languages 

• Simple and minimalist interface, ideal for users with cognitive or mild visual 

disabilities 

• Compatible with screen readers and keyboard navigation. 

• Integration with Google’s accessibility tools, such as ChromeVox and extensions 

to increase contrast. 

Considerations: 

• Does not offer automatic post-meeting transcriptions (unlike Teams) 

• Few visual customization options for users with severe visual disabilities 

 

4. Webex by Cisco Advantages 

• Real-time automatic subtitles and transcriptions 

• Compatible with screen readers and accessible navigation 

• Accessible design adjustments, such as contrast and font size 

Considerations: 

• Less intuitive than other platforms for new users 

 

5. Jitsi Meet (open-source platform) 
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• Simple and customizable interface 

• Compatible with real-time subtitles through third-party integration 

• Works directly in the browser, avoiding complex software installation 

Considerations: 

• Fewer built-in accessibility features by default (requires configuration) 

 

Conclusions  

• Zoom and Microsoft Teams are the most comprehensive options for real-time 

accessibility, especially for their interpreter tools and automatic subtitles 

• Google Meet is ideal for those looking for simplicity and basic accessibility 

features 

• If you need customization, Webex or Jitsi Meet can be valid options with more 

configuration 

 

5. Key aspects in designing distance courses 

 

Designing an accessible online course involves considering several aspects to ensure 

that all students, regardless of their abilities, can effectively engage with the content. 

Accessibility measures and Cognitive Science play a crucial role in designing accessible 

distance learning environments. Cognitive science, which studies how people think, 

learn, and remember, provides insights into how learners process information. By 

understanding cognitive load, memory retention, and learning styles, educators can 

design course materials that are more engaging and easier to understand (Van 

Herwegen, 2023). Accessibility measures ensure that distance learning is inclusive for 

all students. 

 

5.1 Content and navigation design 

Several considerations have to be thought about text content, links and navigation, 

images, color and contrast and document structure. 
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• The page structure and navigation of the web content have to be well defined to 

help users locate the desired content easily and let them browse other sections 

or pages more efficiently. 

• Designers have to use consistent style, naming, and positioning, as well as 

alternative methods of navigation, such as a site map or site search for easy 

access (Das, S., 2024). 

• Descriptive headings, section headings, and labels have to be included to help 

users who can see only a few words at a time know the purpose of the section. 

• The focus order between controls must be in a predictable order to help readers 

using assistive technology read the content aloud. 

• Headings and labels should clearly describe the topic or purpose of the content 

they precede. This is particularly important for users with cognitive or visual 

disabilities, as it helps them orient themselves and predict what each section 

contains. For example, instead of using a vague heading like "Information," a 

more descriptive heading would be "Course Requirements and Deadlines." This 

specificity aids users in quickly finding the information they need. 

• Section Headings are used to organize content into manageable parts. Properly 

structured headings (using HTML tags like <h1>, <h2>, <header>, <nav>, 

<main>, <section>, and <footer>) allow screen readers to create an outline of the 

page, enabling users to jump between sections efficiently. This hierarchical 

structure should be logical and consistent, avoiding skipped heading levels which 

can confuse users. 

• Focus Order: The focus order refers to the sequence in which interactive 

elements (like links, buttons, and form fields) are navigated using the keyboard. 

A predictable focus order is essential for users who rely on keyboard navigation 

or screen readers. It ensures that the content is read aloud in a logical sequence, 

matching the visual layout. For instance, the focus should move from the main 

navigation menu to the content area, and then to the sidebar, following a natural 

reading order. 

 

Integrated information 

The hierarchical organization of information simplifies users' processing and 

understanding of content. This involves implementing clear headings, subheadings, and 

bullet points that help users with learning disabilities grasp the main ideas and navigate 

seamlessly through the information. 
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• Related information has to be presented together rather than separately. For 

example, placing text descriptions close to the corresponding images or 

diagrams. 

• Maintaining a consistent layout throughout the course contributes to help learners 

know where to find information and reducing the cognitive load of navigating 

different formats. 

• Use simplified language and communication, without complex jargon or 

ambiguous terminology. 

• Additionally, include alternative formats, such as audio, video descriptions and 

interactive activities to allow students actively participate in their learning. Offer 

different methods of assessment so that students can demonstrate their 

understanding in various ways. Provide additional resources to help students 

better understand the material, and check these resources are also made 

accessible. 

• Add a glossary. This is very helpful to help students understand unfamiliar words 

and terminology. This can be done, adding a list at the end of a document or by 

pop ups tooltips to specific words that are to be read onscreen (hyperlinks). When 

the students hovers over the hyperlinks, the text will appear. 

 

Use of white space 

White space, also known as negative space, is a fundamental element in design that 

significantly affects the user experience and the overall effectiveness of a design. 

1. Improves Readability and Comprehension 

White space enhances the legibility of text by providing breathing room around 

words and paragraphs. This makes it easier for users to read and understand 

the content. 

2. Creates a Balanced and Harmonious Layout 

Using white space effectively helps to balance the visual elements on a page. It 

prevents the design from feeling cluttered and overwhelming, creating a more 

harmonious and aesthetically pleasing layout. 

3. Guides User Attention 
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White space can be used strategically to draw attention to specific elements, 

such as calls to action or important information. By isolating these elements with 

ample white space, you can make them stand out more. 

4. Enhances User Experience 

A well-designed layout with sufficient white space can make a website or 

document more user-friendly. It allows users to navigate the content more easily 

and find the information they need without feeling overwhelmed. 

5. Increases Focus and Retention 

White space helps to reduce cognitive load by breaking up large chunks of 

information into more digestible sections. This can improve focus and retention, 

making it easier for users to process and remember the information. 

6. Conveys a Sense of Elegance and Sophistication 

Designs that incorporate ample white space often appear more modern and 

sophisticated. It can give a sense of luxury and quality, which can be particularly 

important for branding and marketing materials. 

Types of White Space 

• Micro White Space: The small spaces between lines of text, letters, and 

paragraphs. 

• Macro White Space: The larger spaces around major design elements, such as 

margins and the space between content blocks. 

 

Visual and structural design 

Make all content easy to see and read 

The format and layout of text can make a large difference to the accessibility of your 

document, especially for learners with low-vision and learning difficulties. One of the 

interesting ideas behind Universal Design is that the accommodations for some learners 

benefit everyone. This is true in the way that a more legible font, a readable font-size, a 

clear layout and structure can benefit everyone, whilst also being more accessible for 

learners who require them. 

 

Format and font style 
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• Icons and fonts that every visitor, regardless of their disability, can understand 

have to be used. 

• Line spacing of at least 1.5 times the font size and spaces after paragraphs of at 

least 2 times the font size 

• Font size should not be smaller than 10 points. 

• The visible focus state of input elements has to be defined to help people with 

attention limitations find the location of the focus, eliminating the possibility of 

sudden change in context, which may be jarring for people with cognitive 

disabilities 

• Labels have to be provided to help identify all form controls, and instead of using 

placeholders, labels convey information about a field. 

 

Use visual cues to help guide users throughout the course 

These will provide additional context and help to many users with learning difficulties. 

Thus, they will interpret and associate information more effectively. Make interactive 

elements identifiable. 

• Use clear visual cues such as underlines for links and distinct styles for buttons. 

• Ensure that these elements are keyboard accessible. 

 

Complex images 

Informative, functional, and complex images (such as graphs and diagrams) have to be 

used with alternative text for one image to provide information for the group of images 

as a whole. 

 

Colors 

Avoid using color alone. Don not rely solely on color to convey information. The use of 

colors has to be supplemented with additional color-agnostic identification methods, 

such as labels on graphs, text labels, patterns or icons. 

 

Form and error handling 

Accessible Forms 
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• Use Semantic HTML: Start by using the correct HTML elements for form controls. 

For example, use <label> for labels, <input> for input fields, and <button> for 

buttons. This helps screen readers and other assistive technologies understand 

the structure and purpose of each element. 

• Labeling Controls: Ensure that every form control has a corresponding <label> 

element. The for attribute of the <label> should match the id of the form control. 

This association helps screen readers announce the label when the user focuses 

on the control. 

• Grouping Related Controls: Use <fieldset> and <legend> elements to group 

related form controls. This is particularly useful for sets of radio buttons or 

checkboxes, providing a clear context for users. 

• Instructions and Help Text: Provide clear instructions and help text for completing 

the form. Place these instructions near the relevant form controls, and use the 

aria-described by attribute to link help text to the form control. 

• Input Types and Attributes: Use appropriate input types (e.g., email, tel, number) 

and attributes (e.g., required, maxlength) to help users enter data correctly and 

to trigger built-in validation in browsers. 

 

Error Handling 

• Real-Time Validation: Implement real-time validation to provide immediate 

feedback as users fill out the form. This can prevent errors before the form is 

submitted and guide users to correct mistakes promptly. 

• Clear Error Messages: When errors occur, display clear and specific error 

messages. These messages should explain what went wrong and how to fix it. 

Place error messages near the relevant form controls and use aria-live regions 

to ensure screen readers announce them. 

• Focus Management: When an error occurs, move the focus to the first form 

control with an error. This helps users quickly locate and address the issue. Use 

JavaScript to manage focus appropriately. 

• Accessible Error Indicators: Use visual cues (like color and icons) along with text 

to indicate errors. Ensure that these cues are perceivable by all users, including 

those with color blindness. For example, use both color and an icon to highlight 

errors. 
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• Summary of Errors: Provide a summary of all errors at the top of the form after 

submission. This summary should list all the errors and link to the corresponding 

form controls, allowing users to navigate directly to each issue. 

 

5.2 Clear learning objectives and use of language 

One of the key principles is Cognitive Load Theory, which emphasizes managing the 

amount of information that learners are required to process at any given time (Sweller 

et. al 2011). 

• To avoid overwhelming students, information should be segmented into smaller, 

manageable chunks, besides use of clear and concise language, and provide 

visual aids such as diagrams and charts to support textual information. 

Some other concerns have to be considered to create a more cohesive and effective 

distance learning experience that minimizes split-attention and enhances learner 

engagement. Split-attention occurs when learners are required to split their attention 

between at least two sources of information that have been separated either spatially or 

temporally (Sweller et. al 2011). 

One motivational factor is goal setting. 

• Clear, achievable goals help students stay focused and motivated. Both short-

term and long-term goals can provide direction and a sense of purpose 

(Ambrose; 2010). This way, assure each module has clear, measurable learning 

objectives and activities align with these objectives. 

• Clearly state your expectations for broad participation in discussions and explain 

how students will be evaluated and graded. 

• Additionally, summaries and key points aid in comprehension and retention. 

Some specific learning disabilities affect the ability to read, write, or process information. 

A student with a learning disability may use a speech output or screen enlargement 

system similar to those used by people with visual impairments. They may have difficulty 

understanding websites when the information is cluttered and when the screen layout 

changes from one page to the next. 

Therefore, when writing content for students you should seek to: 

• Keep your sentences short 

• Use active verbs 
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• Use “you” and “we” 

• Use words that are appropriate for the reader 

• Give additional synonyms for complex words 

• Use acronyms and write out the full term 

• Use plain language and avoid jargon and link all difficult to understand terms to 

a glossary. 

 

Scaffolding 

A crucial strategy in cognitive design is implementing scaffolding throughout the course 

to help students build on their existing knowledge and skills. 

• Equally providing temporary support to students as they learn new concepts, 

through guided practice, where step-by-step instructions should be offered and 

gradually reduced as students become more proficient. 

• This includes providing examples and nonexamples and offering opportunities 

for practice and feedback. 

• Timely and constructive feedback is needed to help students understand their 

progress and areas for improvement through forums, email and regular check-

ins and support from instructors. 

• Assess student needs. Begin by understanding the diverse needs of your 

students, their abilities, backgrounds and learning styles. 

• Break down complex tasks. Divide complex tasks into smaller, more manageable 

steps. This makes it easier for students to understand and complete each part of 

the task. 

• Use visual supports and graphic organizers like charts, diagrams and give written 

alternatives as well 

• Provide step-by-step instructions 

• Encourage collaborative learning 

• Give regular feedback and check-ins 

• Gradual release of responsibility 

 

Personalized learning experience 

The learning experience can be personalized to cater to individual student needs and 

preferences. 
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• Providing multiple means of engagement, representation, and expression is also 

crucial. This aligns with the principles of Universal Design for Learning (UDL), 

which advocate for offering various ways for students to engage with the material, 

demonstrate their understanding, and express their ideas. For example, 

instructors can use a mix of lectures, group work, hands-on activities, and 

multimedia resources to cater to different learning preferences. Additionally, 

offering flexible assessment methods, such as written assignments, 

presentations, and projects, allows students to showcase their strengths and 

learning in different ways. 

• Moreover, Adaptive Learning Technologies adjust the difficulty of tasks based on 

student performance, and students can choose topics or projects that interest 

them, increasing motivation and engagement. 

• Thus, the course should be designed to be flexible, allowing students to learn at 

their own pace, and be prepared to adapt based on student feedback and 

changing needs. 

• Immediate feedback should be used to allow students to ask questions in real-

time, which helps clarify doubts instantly and enhances understanding. 

• This is why ongoing reflection and adaptation are essential components of 

inclusive teaching. Educators can adjust their teaching strategies on the fly based 

on student’s responses and needs during live sessions, for example. Therefore, 

educators should regularly seek feedback from students about their experiences 

and be willing to adjust their methods and materials accordingly. 

Incorporate diverse perspectives into course content as well. This can be done by: 

• Expanding reading lists to include authors from various backgrounds 

• Using case studies that reflect a range of cultural and social contexts 

• Ensuring that examples and materials used in lectures are representative of 

diverse groups. 

By doing so, educators can help students see the relevance of the course material to 

their own lives and the world around them, which can increase engagement and 

motivation. 

Furthermore, give students time to process material: 

• Pause for students to take a quiet minute to think of responses to key questions 

or jot down new questions. This practice enables everyone to contribute to class 

discussion confidently.  
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• Give students brief opportunities to pair up to discuss key questions and share 

back with the group to provide a stronger basis for individual participation. 

McGraw’s suggestions for encouraging active learning offer many options for 

such interactive work. 

• Connect individually with your students. Encourage students to meet with you 

one-on-one at least once during the semester. 

• Assessment should allow students to demonstrate learning in various ways. 

• Consider a midterm evaluation to gauge students’ level of comfort in the class. 

Good questions will help students reflect on their processes of learning, rather 

than focusing solely on instructor performance or content. 

• Identify areas of student confusion. Leave a minute at the end of class for 

students to anonymously jot down on notecards questions or points of confusion 

from the day’s class. 

• Set high expectations and affirm your students’ abilities. 

 

In addition, for those with learning difficulties: 

• Implement highlighted texts to support students with learning disabilities. This 

approach helps them focus on key information, enhancing their attention and 

comprehension. By visually distinguishing important points, highlighted texts aid 

memory retention and organization, making it easier for students to process and 

recall information. For students with dyslexia, highlighted texts improve 

readability by providing visual anchors, reducing the likelihood of skipping lines 

or words. 

• Additionally, highlighted texts serve as a useful study aid, allowing students to 

quickly review and revise key points, thereby maintaining engagement and 

supporting their academic success. 

• Use mind maps, concept maps, and other types of graphical representations of 

content to facilitate the understanding of complex and lengthy processes. 

Accompanied this by alternative formats that describe the information for 

students with visual impairments. 
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Engaging content 

Motivational and personal factors are also important when planning distance learning 

that enable students to stay and complete their online studies. Several key elements 

come into play. 

• One is self-efficacy because through building confidence through small 

successes and providing support can enhance believes in their ability to succeed 

in their studies. 

• Also, the course content should be relevant to student’s personal and 

professional goals, so they see the value in what they are learning and they 

became more likely to stay engaged (Ambrose, 2010). 

• Check that meaningful connection to learner’s motivation has been considered 

throughout the course focusing on topics clearly related to student’s interests. 

• These concerns include academic performance, time management, financial 

issues, mental health, social integration, career uncertainty, homesickness, and 

access to technology and resources. 

Addressing these concerns through support services, counseling, and effective 

communication can help students navigate their university experience more smoothly 

but also through online course content related to these topics (Kuh et al., 2010). 

• Moreover, engage students through active learning strategies in the learning 

process, making it more interactive and effective. Problem-solving activities, case 

studies, and group projects that present real-world problems for students to solve 

encourage critical thinking and the application of knowledge. Additionally, 

incorporate quizzes, discussions, and hands-on activities to keep students 

engaged. This variety of multimedia and interactive elements maintains student 

engagement. 

• Create opportunities such as assignments, polls, whiteboard activities, problem 

sets, quizzes, labs, and discussion boards to encourage your students to process 

and work with the material, not just passively absorb it.  

• Use your course website or blog to stimulate and continue discussions that may 

invite a wider range of participation. In some instances, students may be more 

comfortable taking risks in online discussions rather than in the classroom.  

• Expand the classroom activity into an online learning environment. Meaningful 

online discussions and collaborative assignments can increase engagement 
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among students who typically learn less effectively in lecture and seminar style 

settings. 

• Tools for asynchronous engagement you might consider include: Ed Discussion, 

VoiceThread, and (if your course is text-heavy) an annotation tool such as 

Hypothesis or Perusall. 

 

Community building 

Building a sense of community and social presence in the online course enhance 

learning outcomes. 

• Encourage collaborative learning in group work and peer-to-peer interactions. 

• Regular communication with students can be maintained through 

announcements, feedback, and virtual office hours, strengthening the instructor's 

presence 

• Foster a supportive and inclusive online learning environment 

• Opportunities for peer feedback and group work enhance social and emotional 

learning. 

 

Encourage collaboration and communication among students to build a sense of 

community. Thus improving course engagement among students. 

 

Training of teaching staff in accessibility 

Training educators in designing accessible distance courses is essential for several 

reasons. 

• Firstly, it ensures that all students, regardless of their abilities, have equal access 

to educational opportunities. 

• By understanding and implementing accessibility principles, educators can 

create inclusive learning environments that accommodate diverse needs. 

• This includes students with disabilities, such as visual, auditory, or physical 

impairments, as well as those with learning difficulties. 

• When courses are designed with accessibility in mind, it eliminates barriers that 

might otherwise prevent these students from fully participating and succeeding 

in their education. 
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• Moreover, ensuring that educators are well-versed in accessibility standards 

helps institutions comply with legal requirements and avoid potential 

discrimination lawsuits. Laws such as the Web Content Accessibility Guidelines 

(WCAG) mandate that educational content must be accessible to all students. 

 

Feedback and Continuous Improvement 

Feedback from students about their learning experiences and accessibility needs is now 

regularly collected. This feedback informs continuous improvements to the course 

design, ensuring that it remains inclusive and effective for all students. 

Teaching and interacting with students remotely is likely to use a variety of digital 

communication tools. Sometimes, video calls for live and real-time communication with 

individuals and groups of students through tools such as Google Meet, Microsoft Teams, 

and WhatsApp have been widely used for this purpose. These tools can include video, 

audio, and captions automatically generated, and text chats (UNICEF, 2021). 

Interaction is crucial for ensuring that learners, especially those with disabilities, feel 

included and helps alleviate the mental health strain of isolation at home. Opportunities 

for interaction can be facilitated in various ways: 

• They can be structured within lessons by asking students to summarize what has 

been said 

• Using polls (with Slido) or voting systems (with Mentimeter) to ask questions of 

each other 

• They can also be unstructured, based around social sessions such as lunch 

breaks, where students naturally interact, play, and share with their peers. A little 

supervision might be beneficial but should be light to allow students to relax 

together. 

• Explain how your students can contact you and how to use office hours. 

• Think carefully about your student’s academic and social experiences, 

preparation and expectations that they bring to coursework. 

• A start-of-day activity from the teacher might help engage students. This can be 

serious (last night's news) or playful (today's funny cat video). If teachers use 

social media for this, there may be some value in using tools that are familiar to 

students. However, it is important to consider whether all learners can join in if 

they wish to. 
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• Using different media and messaging allows a teacher to offer personal support 

by listening to a student explain the challenge and through observation or 

guidance while they try to complete a task. 

 

6. Accessible digital documents 

6.1 Universal Requirements 

Headings 

Headings are text formatting styles used to communicate the organization of the content 

within a page. They provide a structure and outline and allow screen readers and other 

assistive technology to scan the content page just like sighted users. 

Tips 

• Do not use headings to format the text 

• Avoid standalone headings - with no paragraph text below 

• Consistency! If you use H2 in bold, then make all H2 bold throughout 

 

 

Alt Tags 

Alt Text or Alt Tag is a written (short and concise) description of non-text content on web 

pages. Alt Text/Alt Tag is essential for accessibility as the screen reader will read the 

description in place of an image and display the description if the image is not loading in 

the browser. 

Tips 

• Exclude the phrase "an image of" or "a picture of" as the screen reader will 

indicate it's an image 

• Remove the file type extension from the alt text (.jpg, .png, etc.) 

• Consider personal identifiers and positional information (a glimpse of, a partial 

view, etc.) 
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Descriptive Links 

If the link is posted as the URL address, the screen reader will read a raw link 

letter/number/symbol by a letter/number/symbol, one by one. Therefore, it is best to 

describe a link as a descriptive phrase, not a sentence, to avoid confusion. The 

descriptive phrase should consist of the keywords identifying the item. 

Tips 

• Avoid linking ambiguous phrases such as "click here," "go here," "learn more," 

"read this," "start," etc., as these don't convey where the hyperlink will take users 

• Screen reader typically announces a "link" before reading the actual link 

• Do not post raw URLs 

 

 

Color 

Text and color background (foreground) need to have sufficient color contrast. Learners 

who are legally blind, visually impaired, or have color vision deficiency may not be able 

to identify text in color, emphasized text, or highlighted portions of the text. Using color 

as the only way to convey meaning is insufficient to meet accessibility standards. Color 

can be used to convey meaning as long as that meaning is also indicated in some other 

way, such as using italics, bold, a symbol, an identifier, etc. 

Tips 

• Canvas Accessibility Checker will alert you if there is not enough contrast 

• It's okay to use color as long as the meaning is indicated in some other way 

• Add textual reference when describing images or referring to the color on images 
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Lists 

Lists are used to itemize related items. An ordered list may have a numerical or 

alphabetical hierarchy. An unordered list has no hierarchy and should be bulleted. 

A "fake" list is created manually simply by hitting a hard return to a new row or by 

assigning a number, Roman numeral, or a letter. However, the screen reader will not 

announce the list or the items in it as a list. 

Tips 

• Lists should be created using the RCE "list tool" 

• Use an ordered list when the order of the list is important (displayed in numerical 

or alphabet style) 

• Use an unordered list when the order of the list doesn't have a particular order 

(displayed in a variety of bullet styles) 

 

Tables 

Tables are preferred when the content is more complex and requires organizing data. A 

table is a systematic arrangement of data in rows and columns. 

Table scope identifies a caption (title of the table) and whether the cell is a header for a 

row, column, group of rows, or columns and rows. A header row is a top row in the table 

in which the individual cell describes the content in the cells that fall directly below. A 

header column is a left-most column that describes the content in the rows directly to the 

right. 

Tips 
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• Do not use tables to format content (layout, headings, paragraphs, textbox, etc.) 

• Do not use tables to style images (e.g. Home Page buttons) 

• Manually styled tables with added color or highlighted cells do not meet 

accessibility requirements  

 

 

Closed Captions (CC) 

Audio and video files must be accompanied by complete and accurate transcripts and 

closed captioning containing proper punctuation, capitalization, and word matching. 

Captions provide dialogue or a narrative, and audio descriptions provide a non-verbal 

explanation of what's happening on the screen.  

Captions can be open captions (burned into the video that cannot be turned on or off), 

or closed captions (on-screen text that can be turned on or off). 

Tips 

• Avoid using auto-generated or open captions, which are not sufficient for 

accessibility 

• Captions are not read automatically by a screen reader; you need to provide 

instructions ahead of the video on where to access them 

• Best practices require captions to be 99% accurate, which is approximately an 

error every two to three sentences 
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6.2 Accessible Word documents 

Creating accessible Word documents ensures that all users, including those with 

disabilities, can access and understand the content.  

1. Use the Accessibility Checker 

• Use Word's built-in Accessibility Checker to identify and fix accessibility issues 

• Go to “Review” > “Check Accessibility” 

 

2. Use Headings and Styles 

• Use built-in heading styles to create a logical structure 

• Apply styles from the `Home` tab to ensure screen readers can navigate the 

document 
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3. Add Alternative Text to Images 

• Add alt text to images, charts, and other visuals. 

•  Right-click the image, select “Format Picture”, and add a description in the “Alt 

Text” pane. 

 

4. Create Descriptive Hyperlinks 

• Use meaningful link text that describes the destination. 

•  Instead of "click here," use descriptive text like "Read more about 

accessibility." 

5. Use Simple Table Structures 
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• Ensure tables are simple and include header rows 

• Use the “Table Design” tab to mark header rows 

• Use <th> for Headers: Always use <th> for header cells and <td> for data cells 

• Add Captions: Use the <caption> element to provide a brief description of the 

table 

• Define Scope: Use the scope attribute to specify whether a header is for a 

column (col) or a row (row) 

• Ensure Readability: Make sure the table is easy to read and navigate, with clear 

and concise headers 

• Provide Alternative Text: For complex tables, consider providing a summary or 

alternative text to describe the data. 

• For complex tables: Use the scope attribute to define the relationship between 

headers and data cells 

6. Ensure Sufficient Color Contrast 

• Use high-contrast colors for text and background 

•  Check contrast ratios to ensure readability for users with visual impairments 

7. Use Lists for Structure 

• Use bullet points or numbered lists for clarity 

•  Apply list styles from the “Home” tab 

8. Provide Text Descriptions for Audio/Video 

• Include transcripts or captions for multimedia content 

•  Add text descriptions or use captioning tools 

9. Avoid Using Only Color to Convey Information 

• Use text labels or patterns in addition to color 

•  Ensure information is accessible to colorblind users 

10. Test with Assistive Technologies 

• Test your document with screen readers and other assistive technologies 

•  Use tools like JAWS or NVDA to ensure compatibility. 

 

Creating accessible charts and graphs 

1. Use Clear Labels and Descriptions 
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• Chart Titles and Axis Labels: Always include descriptive titles and labels 

for the axes to explain what the chart represents 

• Legends: Use clear and concise legends to distinguish different data 

series 

2. Ensure Sufficient Color Contrast 

• Contrast Ratios: Ensure text and graphical elements have a high contrast 

ratio against the background. Aim for a contrast ratio of at least 4.5:1 for 

text and 3:1 for graphical elements 

• Color Choices: Avoid using color alone to convey information. Use 

patterns, shapes, or text labels in addition to color to ensure the data is 

accessible to colorblind users 

3. Add Alternative Text 

• Alt Text for Images: Provide alternative text descriptions for charts and 

graphs. This helps screen reader users understand the content 

• Detailed Descriptions: For complex charts, include a detailed description 

or a data table that conveys the same information 

 

4. Use Simple and Clear Designs 

• Avoid Overloading: Keep designs simple and avoid clutter. Too much 

information can be overwhelming and difficult to interpret 
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• Consistent Layouts: Use consistent layouts and styles to make it easier 

for users to understand and compare data 

5. Provide Data in Multiple Formats 

• Supplemental Formats: Offer data in multiple formats, such as tables or 

text descriptions, to cater to different learning preferences 

6. Test with Assistive Technologies 

• Screen Readers: Test your charts and graphs with screen readers to 

ensure they are accessible 

• Keyboard Navigation: Ensure that interactive elements within charts are 

navigable using a keyboard 

 

Creating accessible infographics 

1. Use Clear Labels and Descriptions 

• Titles and Labels: Include descriptive titles and labels for all elements. Ensure 

that axes, data points, and legends are clearly labeled. 

• Alt Text: Provide alternative text for images and graphs to describe the content 

for screen reader users 

2. Ensure Sufficient Color Contrast 

• Contrast Ratios: Use high-contrast colors to make text and graphical elements 

distinguishable. Aim for a contrast ratio of at least 4.5:1 for text 

• Color Choices: Avoid relying solely on color to convey information. Use patterns, 

shapes, or text labels in addition to color 

3. Provide Text Descriptions 

• Transcripts: Include a full-text version of the infographic that screen readers can 

recognize. This can be displayed below the infographic or linked to a separate 

page. 

• Detailed Descriptions: For complex infographics, provide detailed descriptions 

that convey the same information as the visual content 

4. Use Simple and Clear Designs 
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• Avoid Clutter: Keep designs simple and avoid overcrowding with too much 

information. 

• Consistent Layouts: Use consistent layouts and styles to make it easier for users 

to understand and compare data. 

5. Implement Keyboard Navigation 

• Interactive Elements: Ensure that all interactive elements, such as buttons and 

links, are accessible via keyboard. Provide clear focus indicators for these 

elements. 

6. Use Semantic HTML 

• Structure: For web-based infographics, use semantic HTML elements to 

structure your content. This includes using headings, lists, and paragraphs 

appropriately. 

7. Create Accessible Tables 

• Table Headers: Use HTML table elements with headers for rows and columns. 

Provide captions or summaries to explain the table's purpose. 

8. Offer Alternative Accessible Versions 

• Alternative Formats: Provide alternative versions of your infographic, such as 

text-only versions or downloadable accessible PDFs 

 

6.3 Accessible PowerPoint presentations 

• Use Built-in Slide Designs: These templates are designed with accessibility in 

mind, ensuring proper reading order and contrast. 

• Add Alt Text to Images: Right-click on an image, select "Edit Alt Text," and 

provide a brief description. This helps screen readers convey the content of the 

image to visually impaired users. 

• Ensure Sufficient Contrast: Use high-contrast colors for text and background to 

make your slides readable for people with low vision or color blindness. 

• Use Accessible Fonts: Choose simple, sans serif fonts like Arial or Calibri, and 

use a font size of at least 18pt. 

• Check Reading Order: Ensure that screen readers read the content on each slide 

in the correct order. You can do this by selecting "Arrange" > "Selection Pane" 

and adjusting the order of items. 
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• Add Captions and Subtitles: For any video or audio content, include captions and 

subtitles. PowerPoint allows you to add these directly or use embedded captions 

in video files. 

• Use the Accessibility Checker: Go to the "Review" tab and select "Check 

Accessibility." This tool will highlight any accessibility issues and provide 

suggestions for fixing them. 

• Avoid Using Only Color to Convey Information: Use text labels or patterns in 

addition to color to ensure that information is accessible to those with color vision 

deficiencies. 

 

Using color effectively 

Using color effectively in infographics can greatly enhance their readability, visual 

appeal, and overall impact. 

1. Understand Color Theory 

• Primary Colors: Red, blue, and yellow are the foundation of all other colors 

• Secondary Colors: Green, orange, and purple are created by mixing primary 

colors 

• Tertiary Colors: These are combinations of primary and secondary colors 

2. Match Colors to the Mood 

• Warm Colors: Red, orange, and yellow can evoke excitement, energy, and 

warmth. 

• Cool Colors: Blue, green, and purple can convey calmness, trust, and 

professionalism 

3. Use the 60-30-10 Rule 

• 60%: Dominant color 

• 30%: Secondary color 

• 10%: Accent color This rule helps create a balanced and visually appealing color 

scheme 
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4. Ensure Sufficient Contrast 

• Text and Background: Use high contrast between text and background to 

improve readability. For example, dark text on a light background or vice versa 

• Color Blindness: Avoid relying solely on color to convey information. Use 

patterns, textures, or labels to differentiate elements 

5. Stick to a Limited Color Palette 

• 2-3 Colors: Using a limited number of colors can make your infographic look 

cohesive and professional 

• Brand Colors: Incorporate your brand colors to maintain consistency with your 

overall branding 

6. Use Color to Guide Attention 

• Highlight Key Information: Use bold or contrasting colors to draw attention to 

important data points or sections 

• Consistent Use: Apply colors consistently to similar types of information to help 

users quickly understand the structure 

7. Consider Cultural Associations 

• Cultural Meanings: Be aware of cultural differences in color meanings. For 

example, red can signify luck in some cultures and danger in others 

8. Test Your Design 

• Accessibility Tools: Use tools to check color contrast and ensure your design is 

accessible to all users. 
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• Feedback: Get feedback from others to see how they perceive the colors and 

overall design 

 

How to create accessible PDFs from PowerPoint presentations 

1. Prepare Your PowerPoint Presentation 

• Follow best practices for accessibility in PowerPoint, such as using built-in 

slide layouts, adding alt text to images, ensuring sufficient color contrast, and 

using accessible fonts 

2. Run the Accessibility Checker 

• Go to the "Review" tab and select "Check Accessibility." This tool will identify 

any accessibility issues in your presentation and provide suggestions for 

fixing them 

3. Save as PDF with Accessibility Tags 

• Once your presentation is accessible, go to "File" > "Save As" or "File" > 

"Save a Copy" 

• In the "Save as type" dropdown, select PDF (*.pdf) 

• Click on "Options" and ensure that the "Document structure tags for 

accessibility" checkbox is selected 

• Click "OK" and then "Save" 

4. Verify the PDF Accessibility 

• Open the PDF in Adobe Acrobat Pro 

• Use the "Accessibility" tools to check and fix any remaining issues This 

includes verifying the reading order, adding tags, and ensuring all interactive 

elements are accessible. 

 

6.4 Accessible PDF documents 

Accessible PDFs provide a structured format that assistive technologies can interpret, 

making the content understandable and navigable. Accessible PDFs enhance the user 

experience for all readers, not just those with disabilities. Features like searchable text, 

clear navigation, and high-contrast visuals benefit everyone by making documents easier 

to read and interact with. 

Here are some key steps to prepare accessible PDFs: 
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1. Start with an Accessible Source Document: Use accessible features in your 

source document (e.g., Microsoft Word) such as headings, lists, and 

alternative text for images. 

2. Use Proper Tagging: Ensure that the PDF is properly tagged. Tags define the 

structure of the document, such as headings, paragraphs, lists, and tables, 

making it easier for screen readers to interpret. 

3. Add Alternative Text: Provide alternative text for all non-text elements like 

images, charts, and graphs. This text describes the content of the images for 

users who cannot see them. 

4. Ensure Readable Text: Use clear, simple fonts and ensure there is sufficient 

contrast between text and background colors. 

5. Check Reading Order: Verify that the reading order of the document is logical 

and intuitive. This is crucial for users who rely on screen readers. 

6. Include Descriptive Links: Use descriptive text for hyperlinks so that users 

understand where the link will take them. 

7. Use Accessibility Checkers: Utilize tools like Adobe Acrobat's Accessibility 

Checker to identify and fix accessibility issues. This tool can help ensure that 

your PDF meets accessibility standards such as WCAG 2.0 and PDF/UA. 

 

6.5 Accessibility for specific disabilities 

Visual 

Accessibility in distance learning is crucial for blind and low vision users. By 

incorporating accessible technologies such as screen readers, braille displays, and 

audio descriptions, educational institutions can remove barriers that blind students 

face. This not only enhances their learning experience but also promotes 

independence and confidence. Accessible distance learning platforms allow blind users 

to engage fully with course materials, participate in discussions, and complete 

assignments effectively, thereby leveling the playing field and supporting their 

academic and professional growth as well. 

These would be the minimum required standards: 

• Use of Screen Readers: Clear content structure (hierarchical headings, form 

labels) 

• Adequate Color Contrast: Verified with tools like Contrast Checker 

• Alternative Text for Images 
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• Documents in Accessible Formats: Such as tagged PDFs 

 

• Keyboard-Only Navigation 

 

Hearing 

By incorporating features such as closed captions, sign language interpreters, and 

transcripts for audio materials, educational institutions can create an inclusive 

environment that accommodates the needs of deaf and hard of hearing students. 

These accessibility measures enable deaf and hard of hearing students to fully engage 

with lectures, participate in discussions, and comprehend course materials effectively. 

This not only enhances their learning experience but also promotes their academic 

success and confidence, ensuring they are not left behind in the digital learning 

landscape. 

These would be the minimum required standards: 

• Captions and Transcripts: For all videos and audio content 

• Real-Time Sign Language Interpreters 

• Visual Alerts Instead of Audio-Only Cues 
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Example of video with transcription and subtitles 

 

Motor 

By integrating features such as keyboard navigation, voice recognition software, and 

adaptive hardware, educational platforms can accommodate the diverse needs of 

students with mobility impairments. These tools help overcome physical barriers, 

allowing students to access course materials, complete assignments, and engage in 

interactive activities without hindrance. This not only enhances their learning experience 

but also promotes independence, confidence, and academic success, ensuring that all 

students have the opportunity to thrive in a digital learning environment. 

These would be the minimum required standards: 

• Compatibility with Alternative Input Devices (keyboards, switches) 

• Extended Time for completing tasks or activities 

• Interfaces Free of Complex Interactions (gestures, drag-and-drop) 

 

Learning disabilities 

Accessibility in distance learning is crucial for users with learning difficulties as it ensures 

they can fully engage with and benefit from educational content. By incorporating 
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features such as text-to-speech, customizable text sizes, and interactive learning tools, 

educational platforms can cater to diverse learning needs. These accessibility measures 

help students with learning difficulties process information more effectively, participate 

in discussions, and complete assignments at their own pace. 

These would be the minimum required standards: 

• Clear and Concise Language 

• Customizable Content: Options to adjust colors and text size 

• Flexible Pace for Completing Activities 

• Use of Graphics, Concept Maps, and Summaries 

 

 

7. Multimedia learning principles 

 

Multimedia Learning Principles have to be implemented, combining text, images, and 

audio to enhance learning while balancing these elements to avoid cognitive overload. 

• Information should be presented using both verbal and visual formats to reinforce 

learning, and audio narration should be used instead of on-screen text to explain 

visuals, reducing the cognitive load on the visual channel 

• Creating short online video lectures and assignments in especially challenging 

areas of your course support the many different ways that people learn 

• You might consider using narrated PowerPoint slides 

• Use flashing content for no more than three times per second, using low contrast 

flashes 

• Avoid excessive use of red 

• Use captions and transcripts 

• Use Audio descriptions 

• Careful use handling of moving, blinking, and flashing content 

• Provide multiple formats like video lectures with a written summary or a podcast 

with a detailed transcript 
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8. Assistive technologies 

 

Assistive technologies have been incorporated to enhance accessibility. Regularly test 

your content with various assistive technologies. For example, compatibility with screen 

readers is ensured by using proper HTML tags and ARIA (Accessible Rich Internet 

Applications) landmarks.  

Students with disabilities must be able to use their assistive technologies without issues. 

This includes: 

 

Visual Impairment 

• Screen readers like JAWS, NVDA, or VoiceOver. 

• Screen magnifiers for people with low vision. 

• Complete descriptions of images and graphics. 

 

Motor Impairment 

• Adapted peripherals, such as eye-tracking mice or switches. 

• Dictation systems to enter text by voice. 

 

Hearing Impairment 

• Customizable subtitles in size, color, and background. 

• Visual alternatives to audio content. 

 

Learning Disabilities 

• Customizable texts in size, font type, and colors. 

• Text-to-speech software. 

 

Providing technical support 

Technical support has been established as a vital component for an accessible online 

course. A help desk or support team trained in accessibility issues has to be available. 
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Guides and tutorials on how to use the platform and its accessibility features have also 

have to be considered. 

Regular feedback from students has to be collected to identify and address accessibility 

issues. The course should be continuously improved based on feedback and the latest 

accessibility standards, ensuring it remains inclusive and effective. 

 

Involving people with disabilities 

Involving users with disabilities in the design process provides invaluable feedback on 

functionality, helping to improve the overall solution. This exercise has been particularly 

useful in addressing any challenges that affect ease of use. People with disabilities 

involved in testing, using their own equipment, as they are more comfortable with it, 

improve the quality of the feedback. 

 

9. Course evaluation 

 

Course evaluation is a critical component in designing accessible distance learning 

courses for several reasons. Firstly, it ensures that the courses meet the diverse needs 

of all students, including those with disabilities. By systematically evaluating courses, 

educators can identify and address accessibility barriers, ensuring that all students have 

equal access to educational content and opportunities. 

Secondly, course evaluation helps maintain high standards of quality in online education. 

These evaluations help educators refine their course design, making necessary 

adjustments to improve usability and inclusivity. 

Moreover, regular course evaluations foster continuous improvement. By gathering 

feedback from students and using it to inform course design, educators can create more 

engaging and effective learning experiences. This iterative process ensures that courses 

remain relevant and accessible, adapting to the evolving needs of the student population. 

Thus, it’s crucial to use a variety of assessment types to evaluate both the design of the 

course and the knowledge of the users. 

• Design evaluation 

• User knowledge and satisfaction assessment 



 

Project No. 2021-1-EL01-KA220-HED-000032260 

 

 

49 

 

 

 

9.1 Design evaluation 

To conduct the evaluation of the course design, we can opt for automated checking tools 

and manual testing. By using these two forms of evaluation, we can carry out the 

following types of assessment. 

 

Automated testing 

• Like accessibility audits: Use tools (automated testing) and guidelines 

(like WCAG) to audit the course materials and ensure they meet 

accessibility standards. 

 

Manual testing 

• Usability Testing: Conduct tests with a diverse group of students to 

identify any barriers in the course design. This helps ensure that the 

course is user-friendly and accessible to all. 

• Surveys and Feedback Forms: Regularly collect feedback from 

students about the course design, accessibility features, and overall user 

experience. This can help identify areas for improvement. 

• Focus Groups: Organize discussions with students to gather in-depth 

feedback on the course design and accessibility. 

 

Manual accessibility testing is essential for identifying issues that automated tools might 

miss. Some tools and techniques that can help with manual testing are: 

• Keyboard Navigation: Ensure that all interactive elements can be accessed and 

operated using a keyboard. This is crucial for users who cannot use a mouse. 

• Screen Readers: Test your content with screen readers like JAWS, NVDA, or 

VoiceOver to uncover issues with reading order, alternative text, and interactive 

elements. 

• Color Contrast Analyzers: Tools like the Colour Contrast Analyser (CCA) help 

check the contrast between text and background colors to ensure readability for 

users with visual impairments. 
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• Form Accessibility: Manually test forms to ensure that all fields are properly 

labeled and that users can navigate and submit forms using a keyboard. 

• Content Reviews: Visually inspect your content to ensure that headings, lists, and 

landmarks are correctly marked up and that all elements are accounted for. 

• User Testing: Involve people with disabilities in your testing process. Their 

feedback can provide insights that automated and manual testing might overlook 

 

Conduct regular audits of your content and platform and check whether it is accessible 

on various devices and screen sizes as mobile accessibility is essential as a significant 

portion of users access content via mobile devices. 

 

9.2 User knowledge and satisfaction assessment 

When designing a distance learning course, considering the diversity of students who 

may take it, it is necessary to adjust the user`s evaluation on the content in various ways 

to accommodate diverse learning needs and ensure that all students can demonstrate 

their knowledge effectively. 

 

Formative Assessments 

These are ongoing assessments that provide immediate feedback to students and 

instructors. They help identify areas where students may need additional support and 

allow for adjustments in teaching strategies. Examples include quizzes, discussion 

posts, and interactive activities. 

 

Summative Assessments 

These assessments evaluate student learning at the end of an instructional unit by 

comparing it against some standard or benchmark. Examples include final exams, 

projects, and research papers. It's important to ensure these assessments are 

accessible by providing alternative formats and accommodations as needed. 
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Performance-Based Assessments 

These require students to demonstrate their knowledge and skills through practical 

tasks. Examples include presentations, demonstrations, and portfolios. These 

assessments can be adapted to be more accessible by allowing various formats for 

submission, such as video or audio recordings. 

 

Self-Assessments 

These encourage students to reflect on their learning and identify their strengths and 

areas for improvement. Tools like reflective journals and self-evaluation checklists can 

be used. These assessments help students take ownership of their learning process. 

 

Peer Assessments 

These involve students assessing each other's work. This type of assessment can foster 

collaboration and critical thinking. It's important to provide clear guidelines and criteria to 

ensure fairness and accessibility. 

 

Adaptive Assessments 

These are tailored to the individual needs of each student, adjusting the difficulty level 

based on their responses. Adaptive assessments can be particularly useful for students 

with diverse learning needs, as they provide a personalized assessment experience. 

 

Satisfaction Assessments 

Regular assessments of student satisfaction is often a requirement for accreditation and 

quality assurance processes. Additionally, it gives feedback on the needs and 

preferences of students and also can lead to improvements in the instructional materials, 

the teaching methods, and the usability of the learning management system. 

 

10. General Guidelines 
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This section includes general guidelines, which have emerged as findings of the 

research conducted within the project "HOLISTIC APPROACH TO ACCESSIBLE 

HIGHER EDUCATION (HEDforALL)" with university students with disabilities (visual 

impairments, hearing impairments, physical/mobility impairments, and specific 

learning disabilities). Therefore, these guidelines are of particular importance, as they 

represent the suggestions and wishes of students with disabilities themselves, in order 

to achieve access to distance education. Some of the guidelines apply to all four groups 

of university students with disabilities. In practice, these requirements were reported 

during the survey by all four groups of students with disabilities. Some of the 

requirements were reported by specific groups only, and there were requirements 

reported by only one group of participants. Below all requirements are listed. 

 

Requirements for all four groups of students with disabilities 

1. Provide accessible educational material (e.g., PDF documents, presentations, 

videos). 

2. Provide the educational material early, before the course begins. 

3. Ensure technical/accessibility support is available. 

4. Allow flexibility in deciding the pace of the educational program by the student 

with a disability. 

5. Allow participation from any location the student chooses. 

6. Ensure that lectures are recorded (with captions for students with hearing 

impairments). 

7. Provide an accessible platform. 

8. Provide administrative support. 

9. Ensure sufficient time during exams and other activities. 

10. Ensure smooth and organized use of necessary tools during the course to 

enable students with disabilities to follow. 

11. Provide breaks and flexibility for completing courses and exams to avoid 

fatigue. 

12. Provide regular feedback and communication with professors. 
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Requirements for students with hearing impairments, physical/mobility 

impairments, and specific learning disabilities 

1. Provide communication channels for real-time interaction with students (e.g., 

text box). 

2. Provide communication channels for students outside class time. 

 

Requirements for students with visual impairments, physical/mobility 

impairments, and specific learning disabilities 

1. Provide the ability for oral participation in class. 

2. Follow a hybrid model (distance learning and physical attendance) to allow 

meeting with students and teachers in person. 

 

Requirements for students with visual impairments, physical/mobility 

impairments, and hearing impairments 

1. Provide access to accessible tools/information (e.g., accessible websites, 

databases). 

 

Requirements for students with visual impairments and physical/mobility 

impairments 

1. Provide communication channels with professors outside class time. 

2. Provide communication channels with professors for real-time interaction (e.g., 

accessible text box). 

 

Requirements for students with visual impairments and specific learning 

disabilities 

1. Allow the choice of examination format (e.g., oral examination, paper 

composition, written exams). 

 

Requirements for students with visual impairments 



 

Project No. 2021-1-EL01-KA220-HED-000032260 

 

 

54 

 

1. Provide various platforms for communication and educational purposes (e.g., 

Moodle, Skype). 

2. Ensure sufficient time for filling out documents and various forms. 

3. Provide accessible documents and forms that need to be filled out. 

4. Ensure that students can tell when their camera or others’ cameras are on/off. 

5. Allow participation in the lecture (e.g., "raise hand" via the digital feature of a 

distance education platform). 

6. Avoid using symbols or special fonts to emphasize content, as these are not 

recognized by screen reading programs. 

7. Allow online viewing of presentations with magnification. 

 

Requirements for students with hearing impairments 

1. Provide an automatic captioning feature integrated into the platform for lectures. 

2. Allow online communication with a sign language interpreter. 

3. Ensure the platform allows the interpreter and the professor's presentation to 

appear simultaneously. 

4. Ensure that the professor speaks clearly so that automatic captions work. 

5. The professor should speak near the camera so the student can lip-read easily. 

6. Provide telecommunication relay services (e.g., a communication assistant 

serves as a bridge between two callers, such as Tess). 

7. Provide detailed scripts of the lecture to complete missing information delivered 

orally. 

8. Announce the change of speaker. 

  

Requirements for students with mobility impairments 

1. Ensure all necessary information is available online (e.g., announcements, 

program). 

2. Allow participation in the lecture (e.g., "raise hand" via the relevant digital 

feature of a distance education platform). 



 

Project No. 2021-1-EL01-KA220-HED-000032260 

 

 

55 

 

 

Requirements for students with specific learning disabilities 

1. Provide projects to be handed in as a motivating factor. 

2. Allow prior familiarization with digital tools. 

3. Provide an outline of topics to be covered before the course and a summary of 

key subjects after the course. 
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https://support.microsoft.com/en-us/office/record-a-slide-show-with-narration-and-slide-timings-0b9502c6-5f6c-40ae-b1e7-e47d8741161c
https://support.microsoft.com/en-us/office/record-a-slide-show-with-narration-and-slide-timings-0b9502c6-5f6c-40ae-b1e7-e47d8741161c
https://daisy.org/activities/software/obi/
https://www.robobraille.org/
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• The Center for Universal Design in Education 

http://www.uw.edu/doit/programs/center-universal-design-

education/overview  

 

http://www.uw.edu/doit/programs/center-universal-design-education/overview
http://www.uw.edu/doit/programs/center-universal-design-education/overview
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